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2 Copyright Information 
All information contained within this installation guide and accompanying software 
programs is copyright of Infineer Ltd. 

All rights reserved.  It is a breach of copyright if this installation guide is copied or 
reproduced, in whole or part, using any means whatsoever, without the prior written 
approval of Infineer Ltd. 

Infineer Ltd gives no condition or warranty, expressed or implied, about the fitness of this 
installation guide or accompanying software product.  Infineer reserve the right to make 
changes to this installation guide or the accompanying software product without notice to 
any person or company. 

Infineer Ltd shall not be liable for any indirect, special, consequential or incidental damages 
resulting from the use of this installation guide or the accompanying software whether 
caused through Infineer's negligence or otherwise. 

Infineer Ltd 
Balloo Avenue 
Bangor 
Northern Ireland 
BT19 7QT
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3 Minimum specification information 
This section includes information about the specifications required by a system to run 
ChipNet3. 

Before you install the product, you should make sure that the computer meets the minimum 
system requirements. 

 

3.1 ChipNet3 Server Requirements 

Minimum Requirements 

·  IBM compatible computer with a 550 MHz Pentium processor 
·  512MB RAM 
·  At least 200MB of free disk space after OS and SQL server has been installed 

+ 1MB per 10000 transactions 
·  SVGA video card supporting 800x600 pixels and 256 colours 
·  CD drive 
·  2 free USB ports 
·  10/100 NIC  

 

Recommended Requirements 

·  IBM compatible computer with a 1 GHz Pentium processor 
·  1GB RAM 
·  At least 200MB of free disk space after OS and SQL server has been installed 

+ 1MB per 10000 transactions 
·  SVGA video card supporting 1024x726 pixels and 24-bit true colour 
·  CD/DVD rewriter 
·  3 free USB ports 
·  10/100 NIC  

 

3.2 ChipNet3 Client Requirements 

Minimum Requirements 

·  IBM compatible computer with a 550 MHz Pentium processor 
·  256MB RAM 
·  At least 50MB of free disk space after OS has been installed 
·  SVGA video card supporting 800x600 pixels and 256 colours 
·  CD drive 
·  1 free USB ports 
·  10/100 NIC  

 

Recommended Requirements 

·  IBM compatible computer with a 1 GHz Pentium processor 
·  512MB RAM 
·  At least 50MB of free disk space after OS has been installed 
·  SVGA video card supporting 1024x726 pixels and 24-bit true colour 
·  CD/DVD rewriter 
·  1 free USB ports 
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·  10/100 NIC  

 

3.3 Operating Systems Supported 

·  Microsoft Windows XP Professional SP2 
·  Microsoft Windows 2000 Professional 
·  Microsoft Windows 2000 Server 
·  Microsoft Windows Server 2003 Server 

 

3.4 Databases Supported 

·  Microsoft SQL Server 2000 
·  Microsoft SQL Desktop Engine 

 

3.5 Remote Access Requirements 

Minimum Requirements 

·  Dial up access via modem fitted to server 

 

Recommended Requirements 

·  Access via IP connection 
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4 Installation Requirements 
Before installation of Chipnet3, the system administrator must determine the type of 
database to be used. Chipnet3 will operate on the following database technologies 

·  SQL Server 2000 

·  Microsoft SQL Server 2000 Desktop Engine (MSDE) 

No other database technologies are supported. 

If SQL Server 2000 is to be the database technology used then it will be necessary to 
install SQL Server prior to continuing with the ChipNet3 installation. If MSDE is to be the 
database technology used then this can be installed as part of the ChipNet3 installation. 

The installation is split into 5 possible options: 

 

Option 1: Database including MSDE Installation with ChipNet3 Components 

This option is for a system with no database server installed. It will allow the selection of 
any or all of the ChipNet3 components. The following will be installed: 

MSDE 

ChipNet3 Database 

ChipNet3 Components (Selectable) 

Security Key Software (Selectable) 

 

Option 2: Database onto existing SQL Server with ChipNet3 Components 

This option is for a system that has SQL Server 2000 already installed. It will allow the 
selection of any or all of the ChipNet3 components. The following will be installed: 

ChipNet3 Database 

ChipNet3 Components (Selectable) 

Security Key Software (Selectable) 

 

Option 3: Database including MSDE Installation without ChipNet3 Components 

This option is for a system with no database server installed. The following will be installed: 

MSDE 

ChipNet3 Database 

Security Key Software (Selectable) 

 

Option 4: Database onto existing SQL Server without ChipNet3 Components 

This option is for a system that has SQL Server 2000 already installed. The following will 
be installed: 

ChipNet3 Database 

Security Key Software (Selectable) 
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Option 5: ChipNet3 Components Only 

This option will allow the installation of ChipNet3 components only. The following will be 
installed: 

ChipNet3 Components (Selectable) 

Security Key Software (Selectable) 
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5 Installation Option 1 
Installation Option 1 will install the following: 

·  Microsoft Desktop Engine (MSDE) 

·  ChipNet3 Database 

·  ChipNet3 Components (Selectable) 

·  Security Key Software (Selectable) 

Please follow the instructions below. Some screens may differ slightly depending on the 
options selected and the operating system in use. 

1. Open the ChipNet3 folder. 

2. Run the file named C3Install.exe. The following welcome screen is displayed: 

 

3. Click on the Next button.  The Select Installation Type screen is displayed: 

 

4. Ensure the Database including MSDE Installation with ChipNet3 Components 
is selected. Click on the OK button. 

 

5. The install will begin searching for any files that may be already on the PC, this 
process may take several minutes. Once the search is complete the Select 
Components screen is displayed: 
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6. Select the components for installation. Depending on the components selected 
some of the following screens may not be displayed. Click on the Next button.  The 
country selection screen is displayed. 

 

7. Selecting United States Install will install reports that are in legal paper size. 
Selecting UK / European Install will install reports that are in A4 paper size. Once a 
location is selected click the Next button and the Choose Destination Location 
screen is displayed: 

 

8. This screen permits the selection of an alternative install directory for ChipNet3. It 
is advisable to install ChipNet3 in the recommended default directory. Once a 
location is selected click the Next button. The Select Program Manager Group 
screen is displayed: 
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9. Click on the Next button.  The Reader Type screen is displayed: 

 

10. Select the type of card reader being installed. If USB is selected, the USB card 
reader install must be run after immediately after the ChipNet3 install is complete. 
Click on the OK button. The Uniwell Direct screen is displayed. 

 

11. Select Yes to install the necessary files for Uniwell Direct or No if Uniwell Direct is 
not to be installed. Selecting Yes will cause the FileZilla ftp server to be installed as 
part of the ChipNet3 installation. Click on the OK button. The Reports screen is 
displayed. 
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12. Select Yes to install the report files or No if the report files are not to be used. The 
Reports Path screen is displayed. 

 

13. This screen determines where the reports are to be stored; it is recommended that 
the reports are stored on a network drive. Storing the report files in a central 
location permits any new or modified reports to be available immediately to all 
reporting PCs on the system. Click on the OK button. The Admin User Name 
screen is displayed. 

 

14. Enter the administrator username for the database. Click on the OK button. The 
Password screen is displayed. 
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15. Enter the administrator password for the database. Click on the OK button. The 
Database Name screen is displayed. 

 

16. Enter the name for the ChipNet3 database. Click on the OK button. The Installing 
screen is displayed. 

 

17. After a short wait the Microsoft SQL Server Desktop Engine screen is displayed: 

 

18. Use this screen to view the progress of the installation. Depending on the machine, 
this may take up to several minutes. When MSDE installation is complete, yhe 
following screen will be displayed in Windows 2000. 
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19. The NO option must be selected. Do not select Yes otherwise the ChipNet3 
installation will not complete. 

 

20. Once the OSQL has been located the following window will be displayed.  

 

21. This screen will be displayed for a brief time. The Warning screen is displayed. 

 

22. If this a new install click the OK button and continue. If this is not a new install 
please ensure that the listed services are not running and then click the OK button. 
The following Install window is displayed. 

 

23. Once these files have been installed the Rainbow Key window will be displayed.  
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24. The Rainbow Key is the security key application. This is normally installed on the 
PC holding the database. Select Yes to install the Rainbow Key software, No to 
skip this option. The following screen will be displayed 

 

25. Press the Next button. The following screen is displayed: 

 

26. Select the I accept the terms in the license agreement radio button. Press the 
Next button. The following screen is displayed: 

 

27. Press the Next button. The following screen is displayed: 
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28. Select the Complete radio button. Press the Next button. The following screen is 
displayed: 

 

29. This screen warns about having USB software keys connected. Press the Install 
button to begin the installation. The installation will display several screens and 
once the installation is complete the following screen is displayed: 

 

30. Click on the Finish button to exit the installation. Connect the software key to the 
correct port on the machine and record the name of the PC the software key is 
attached. The following screen is displayed: 
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31. Click on the I Agree button. The Choose Components screen is displayed. 

 

32. Ensure only the FileZilla Server box is checked. Click on the Next button. The 
Choose Install Location screen is displayed. 

 

33. Install FileZilla Server in the default location. Click on the Next button. The Startup 
Settings screen is displayed. 
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34. Ensure the following startup values 

a. Install as service, started with Windows (default) 

b. Port Number – 14147 

c. Start if user logs on, apply to all users (default) 

d. Both Start Server after setup completes and Start Interface after setup 
completes are selected. 

Click on the Install button. The Installation Complete screen is displayed. 

 

35. After a short time the Close button will become active. Click the Close button and 
the Connect to Server screen is displayed. If the HTML Help Update Program 
window appears, drag it away from the Connect to Server window and continue. 

 

36. Ensure the following startup values 

a. Server Address – 127.0.0.1 

b. Port – 14147 
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c. Always connect to the server is selected. 

Click on the OK button. The FileZilla server screen is displayed. 

 

37. Click on the User Accounts icon at the top of the FileZilla server screen as shown. 
The Users screen is displayed. 

 

38. Click on the Add button at the bottom of the Users box. The Add User Account 
screen is displayed. 

 

39. Type administrator into the top box as shown and click on the OK button. The 
administrator account appears in the Users box.. 
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40. Click on the Add button at the bottom of the Access Rights box. The Browse for 
Folder screen is displayed. 

 

41. Using the tree structure, browse to the following directory: 

C:\Program Files\Infineer\ChipNet3\Card Production\Import 

Click on the OK button. The Users screen is displayed. 

 

42. In the Files box ensure the following values are selected: 

Read, Write, Delete, Append 

In the Directories box ensure the following values are selected: 

Create, Delete, List, + Subdirs 

Click on the OK button. The FileZilla Server screen is displayed. 

 

43. From the Edit menu select the Settings option. The FileZilla Server Options window 
will be displayed: 
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44. From the options on the left pane select Miscellaneous and the Miscellaneous 
options will be displayed in the right pane. Ensure the Start miniminised option is 
selected. Click the OK button. The FileZilla Server window will be displayed: 

 

45. From the File menu select the Quit option. Drag the HTML Help Update Program 
window to the centre of the screen. 

 

46. Click Yes to install the HTML help, or No not to install the HTML help. If Yes is 
selected HTML Help Update Program screen is displayed. 

 

47. The following MDAC installation screen is displayed in Windows 2000. 

 

48. After a short while the following License screen is displayed. 
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49. Ensure I accept all of the…. is selected. Click the Next button. The following 
checking disk space screen is displayed. 

 

50. After a few moments several installing software screens will be displayed until the 
following security edit screen is displayed. 

 

51. After a short pause the Setup is Complete screen is displayed. 
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52. Click on the Close button. The following MDAC 2.8 RTM screen is displayed only 
in Windows XP. 

 

53. This screen will be displayed when installing on certain versions of Windows XP. 
Click on the Cancel button. The Installation Complete screen is displayed. 

 

54. Installation of the ChipNet3 files is complete is complete, please click on the Finish 
button. The Restart message screen will be displayed. 

 

55. In order to complete the installation the PC must be restarted. Click on the OK 
button. 

 

56. Click on the OK button to restart the PC. 
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6 Installation Option 2 
Installation Option 2 will install the following: 

·  ChipNet3 Database 

·  ChipNet3 Components (Selectable) 

·  Security Key Software (Selectable) 

Please follow the instructions below. Depending on the components selected some 
screens may not appear. 

1. Open the ChipNet3 folder. 

2. Run the file named C3Install.exe. The following welcome screen is displayed: 

 

3. Click on the Next button.  The Select Installation Type screen is displayed: 

 

4. Ensure the Database onto existing SQL Server with ChipNet3 Components is 
selected. Click on the OK button. 

 

5. The install will begin searching for any files that may be already on the PC, this 
process may take several minutes. Once the search is complete the Select 
Components screen is displayed: 



ChipNet3  Installation guide 

Ó Infineer Ltd 2006  Version 2.1 Page 25 

 

6. Select the components for installation. Depending on the components selected 
some of the following screens may not be displayed. Click on the Next button.  The 
country selection screen is displayed. 

 

7. Selecting United States Install will install reports that are in legal paper size. 
Selecting UK / European Install will install reports that are in A4 paper size. Once a 
location is selected click the Next button and the Choose Destination Location 
screen is displayed: 

 

8. This screen permits the selection of an alternative install directory for ChipNet3. It 
is advisable to install ChipNet3 in the recommended default directory. Once a 
location is selected click the Next button. The Select Program Manager Group 
screen is displayed: 
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9. Click on the Next button.  The Reader Type screen is displayed: 

 

10. Select the type of card reader being installed. If USB is selected, the USB card 
reader install must be run after immediately after the ChipNet3 install is complete. 
Click on the OK button. The Uniwell Direct screen is displayed. 

 

11. Select Yes to install the necessary files for Uniwell Direct or No if Uniwell Direct is 
not to be installed. Selecting Yes will cause the FileZilla ftp server to be installed as 
part of the ChipNet3 installation. Click on the OK button. The Reports screen is 
displayed. 
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12. Select Yes to install the report files or No if the report files are not to be used. The 
Reports Path screen is displayed. 

 

13. This screen determines where the reports are to be stored; it is recommended that 
the reports are stored on a network drive. Storing the report files in a central 
location permits any new or modified reports to be available immediately to all 
reporting PCs on the system. Click on the OK button. The Admin User Name 
screen is displayed. 

 

14. Enter the administrator username for the database. Click on the OK button. The 
Password screen is displayed. 
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15. Enter the administrator password for the database. Click on the OK button. The 
Database Name screen is displayed. 

 

16. Enter the name for the ChipNet3 database. Click on the OK button. The Server 
Name screen is displayed. 

 

17. Enter the name for the ChipNet3 server. Click on the OK button. The Warning 
screen is displayed. 
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18. Please ensure SQL Server and SQL Server Agent are running. Click on the OK 
button. The Installing screen is displayed. 

 

19. After a short wait the Windows Installer screen is displayed: 

 

20. After a short wait the Microsoft SQL Server Desktop Engine screen is displayed: 

 

21. Use this screen to view the progress of the installation. Depending on the machine, 
this may take up to several minutes. When MSDE installation is complete, yhe 
following screen will be displayed in Windows 2000. 

 

22. The NO option must be selected. Do not select Yes otherwise the ChipNet3 
installation will not complete. 

 

23. Once the OSQL has been located the following window will be displayed.  

 

24. This screen will be displayed for a brief time. The Warning screen is displayed. 



ChipNet3  Installation guide 

Page 30  Version 2.1 Ó Infineer Ltd 2006 

 

25. If this a new install click the OK button and continue. If this is not a new install 
please ensure that the listed services are not running and then click the OK button. 
The following Install window is displayed. 

 

26. Once this batch of files have been installed the Rainbow Key window will be 
displayed.  

 

27. The Rainbow Key is the security key application. This is normally installed on the 
PC holding the database. Select Yes to install the Rainbow Key software, No to 
skip this option. 

 

28. Press the Next button. The following screen is displayed: 
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29. Select the I accept the terms in the license agreement radio button. Press the 
Next button. The following screen is displayed: 

 

30. Press the Next button. The following screen is displayed: 

 

31. Select the Complete radio button. Press the Next button. The following screen is 
displayed: 
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32. This screen warns about having USB software keys connected. Press the Install 
button to begin the installation. The installation will display several screens and 
once the installation is complete the following screen is displayed: 

 

33. Click on the Finish button to exit the installation. Connect the software key to the 
correct port on the machine and record the name of the PC the software key is 
attached. The following screen is displayed: 

 

34. Click on the I Agree button. The Choose Components screen is displayed. 
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35. Ensure only the FileZilla Server box is checked. Click on the Next button. The 
Choose Install Location screen is displayed. 

 

36. Install FileZilla Server in the default location. Click on the Next button. The Startup 
Settings screen is displayed. 

 

37. Ensure the following startup values 

a. Install as service, started with Windows (default) 

b. Port Number – 14147 

c. Start if user logs on, apply to all users (default) 
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d. Both Start Server after setup completes and Start Interface after setup 
completes are selected. 

Click on the Install button. The Installing screen is displayed. 

 

38. After a short time the Close button will become active. Click the Close button and 
the Connect to Server screen is displayed. If the HTML Help Update Program 
window appears, drag it away from the Connect to Server window and continue. 

 

39. Ensure the following startup values 

a. Server Address – 127.0.0.1 

b. Port – 14147 

c. Always connect to the server is selected. 

Click on the OK button. The FileZilla server screen is displayed. 

 

40. Click on the User Accounts icon at the top of the FileZilla server screen as shown. 
The Users screen is displayed. 
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41. Click on the Add button at the bottom of the Users box. The Add User Account 
screen is displayed. 

 

42. Type administrator into the top box as shown and click on the OK button. The 
administrator account appears in the Users box. 

 

43. Click on the Add button at the bottom of the Access Rights box. The Browse for 
Folder screen is displayed. 

 

44. Using the tree structure, browse to the following directory: 
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C:\Program Files\Infineer\ChipNet3\Card Production\Import 

Click on the OK button. The Users screen is displayed. 

 

45. In the Files box ensure the following values are selected: 

Read, Write, Delete, Append 

In the Directories box ensure the following values are selected: 

Create, Delete, List, + Subdirs 

Click on the OK button. The FileZilla Server screen is displayed. 

 

46. From the Edit menu select the Settings option. The FileZilla Server Options window 
will be displayed: 

 

47. From the options on the left pane select Miscellaneous and the Miscellaneous 
options will be displayed in the right pane. Ensure the Start minimised option is 
selected. Click the OK button. The FileZilla Server window will be displayed: 
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48. From the File menu select the Quit option. Drag the HTML Help Update Program 
window to the centre of the screen. 

 

49. Click Yes to install the HTML help, or No not to install the HTML help. If Yes is 
selected HTML Help Update Program screen is displayed. 

 

50. The following MDAC installation screen is displayed in Windows 2000. 

 

51. After a short while the following License screen is displayed. 

 

52. Ensure I accept all of the…. is selected. Click the Next button. The following 
checking disk space screen is displayed. 
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53. After a few moments several installing software screens will be displayed until the 
following security edit screen is displayed. 

 

54. After a short pause the Setup is Complete screen is displayed. 

 

55. Click on the Close button. The following MDAC 2.8 RTM screen is displayed only 
in Windows XP. 

 



ChipNet3  Installation guide 

Ó Infineer Ltd 2006  Version 2.1 Page 39 

56. This screen will be displayed when installing on certain versions of Windows XP. 
Click on the Cancel button. The Installation Complete screen is displayed. 

 

57. Installation of the ChipNet3 files is complete is complete, please click on the Finish 
button. The Restart screen will be displayed. 

 

58. In order to complete the installation the PC must be restarted. Click on the OK 
button. 

 

59. Click on the OK button to restart the PC. 
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7 Installation Option 3 
Installation Option 3 will install the following: 

·  Microsoft Desktop Engine (MSDE) 

·  ChipNet3 Database 

·  Security Key Software (Optional) 

Please follow the instructions below. Some screens may differ slightly depending on the 
options selected and operating system in use. 

1. Open the ChipNet3 folder. 

2. Run the file named C3Install.exe. The following welcome screen is displayed: 

 

3. Click on the Next button.  The Select Installation Type screen is displayed: 

 

4. Ensure the Database including MSDE Installation without ChipNet3 
Components is selected. Click on the OK button. 
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5. Enter the administrator username for the database. Click on the OK button. The 
Password screen is displayed. 

 

6. Enter the administrator password for the database. Click on the OK button. The 
Database Name screen is displayed. 

 

7. Enter the name for the ChipNet3 database. Click on the OK button. The Installing 
screen is displayed. 
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8. After a short wait the Windows Installer screen is displayed: 

 

9. After a short wait the Microsoft SQL Server Desktop Engine screen is displayed: 

 

10. Use this screen to view the progress of the installation. Depending on the machine, 
this may take up to several minutes. When MSDE installation is complete, yhe 
following screen will be displayed in Windows 2000. 

 

11. The NO option must be selected. Do not select Yes otherwise the ChipNet3 
installation will not complete. 

 

12. Once the OSQL has been located the following window will be displayed.  

 

13. This screen will be displayed for a brief time. The Installing screen is displayed. 

 

14. Once this batch of files have been installed the Rainbow Key window will be 
displayed.  
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15. The Rainbow Key is the security key application. This is normally installed on the 
PC holding the database. Select Yes to install the Rainbow Key software, No to 
skip this option. The following screen will be displayed. 

 

16. Press the Next button. The following screen is displayed: 

 

17. Select the I accept the terms in the license agreement radio button. Press the 
Next button. The following screen is displayed: 
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18. Press the Next button. The following screen is displayed: 

 

19. Select the Complete radio button. Press the Next button. The following screen is 
displayed: 

 

20. This screen warns about having USB software keys connected. Press the Install 
button to begin the installation. The installation will display several screens and 
once the installation is complete the following screen is displayed: 
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21. Click on the Finish button to exit the installation. Connect the software key to the 
correct port port on the machine and record the name of the PC. The following 
screen is displayed: 

 

22. Installation of the ChipNet3 files is complete is complete, please click on the Finish 
button. The Restart screen will be displayed. 

 

23. In order to complete the installation the PC must be restarted. Click on the OK 
button. 

 



ChipNet3  Installation guide 

Page 46  Version 2.1 Ó Infineer Ltd 2006 

8 Installation Option 4 
Installation Option 4 will install the following: 

·  ChipNet3 Database 

·  Security Key Software (Selectable) 

Please follow the instructions below. Some screens may differ slightly depending on the 
options selected and the operating system in use. 

1. Insert the ChipNet3 Installation CD into the CD drive. 

2. Browse to the CD drive using Microsoft Windows Explorer. 

3. Open the ChipNet3 folder. 

4. Run the file named C3Install.exe. The following welcome screen is displayed: 

 

5. Click on the Next button.  The Select Installation Type screen is displayed: 

 

6. Ensure the Database onto existing SQL Server without ChipNet3 Components 
is selected. Click on the OK button. 
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7. Enter the administrator username for the database. Click on the OK button. The 
Password screen is displayed. 

 

8. Enter the administrator password for the database. Click on the OK button. The 
Database Name screen is displayed. 

 

9. Enter the name for the ChipNet3 database. Click on the OK button. The Installing 
screen is displayed. 
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10. Enter the name for the ChipNet3 server. Click on the OK button. The Installing 
screen is displayed. 

 

11. Please ensure SQL Server and SQL Server Agent are running. Click on the OK 
button. The following screen is displayed. 

 

12. Once the OSQL has been located the following window will be displayed.  

 

13. This screen will be displayed for a brief time. The Rainbow Key screen is 
displayed. 

 

14. The Rainbow Key is the security key application. This is normally installed on the 
PC holding the database. Select Yes to install the Rainbow Key software, No to 
skip this option. The following screen will be displayed. 
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15. Press the Next button. The following screen is displayed: 

 

16. Select the I accept the terms in the license agreement radio button. Press the 
Next button. The following screen is displayed: 

 

17. Press the Next button. The following screen is displayed: 
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18. Select the Complete radio button. Press the Next button. The following screen is 
displayed: 

 

19. This screen warns about having USB software keys connected. Press the Install 
button to begin the installation. The installation will display several screens and 
once the installation is complete the following screen is displayed: 

 

20. Click on the Finish button to exit the installation. Connect the software key to the 
correct port on the machine and record the name of the PC the software key is 
attached. The following screen is displayed: 
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21. Installation of the ChipNet3 files is complete is complete, please click on the Finish 
button. The Restart screen will be displayed. 

 

22. In order to complete the installation the PC must be restarted. Click on the OK 
button. 
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9 Installation Option 5 
Installation Option 5 will install the following: 

·  ChipNet3 Components (Selectable) 

Please follow the instructions below. Some screens may differ slightly depending on the 
options selected and operating system in use. 

·  Insert the ChipNet3 Installation CD into the CD drive. 

23. Browse to the CD drive using Microsoft Windows Explorer. 

24. Open the ChipNet3 folder. 

25. Run the file named C3Install.exe. The following welcome screen is displayed: 

 

26. Click on the Next button.  The Select Installation Type screen is displayed: 

 

27. Ensure the ChipNet3 Components Only is selected. Click on the OK button. 

 

28. The install will begin searching for any files that may be already on the PC, this 
process may take several minutes. Once the search is complete the Select 
Components screen is displayed: 
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29. Select the components for installation. Depending on the components selected 
some of the following screens may not be displayed. Click on the Next button.  The 
country selection screen is displayed. 

 

30. Selecting United States Install will install reports that are in legal paper size. 
Selecting UK / European Install will install reports that are in A4 paper size. Once a 
location is selected click the Next button and the Choose Destination Location 
screen is displayed: 

 

31. This screen permits the selection of an alternative install directory for ChipNet3. It 
is advisable to install ChipNet3 in the recommended default directory. Once a 
location is selected click the Next button. The Select Program Manager Group 
screen is displayed: 
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32. Click on the Next button.  The Reader Type screen is displayed: 

 

33. Select the type of card reader being installed. If USB is selected, the USB card 
reader install must be run after immediately after the ChipNet3 install is complete. 
Click on the OK button. The Uniwell Direct screen is displayed. 

 

34. Select Yes to install the necessary files for Uniwell Direct or No if Uniwell Direct is 
not to be installed. Selecting Yes will cause the FileZilla ftp server to be installed as 
part of the ChipNet3 installation. Click on the OK button. The Reports screen is 
displayed. 
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35. Select Yes to install the report files or No if the report files are not to be used. The 
Reports Path screen is displayed. 

 

36. This screen determines where the reports are to be stored; it is recommended that 
the reports are stored on a network drive. Storing the report files in a central 
location permits any new or modified reports to be available immediately to all 
reporting PCs on the system. Click on the OK button. The Admin User Name 
screen is displayed. 

 

37. Enter the administrator username for the database. Click on the OK button. The 
Password screen is displayed. 
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38. Enter the administrator password for the database. Click on the OK button. The 
Database Name screen is displayed. 

 

39. Enter the name for the ChipNet3 database. Click on the OK button. This screen will 
be displayed for a brief time. The Warning screen is displayed. 

 

40. If this a new install click the OK button and continue. If this is not a new install 
please ensure that the listed services are not running and then click the OK button. 
The following Install window is displayed. 

 

41. Once this batch of files has been installed the FileZilla Server window will be 
displayed.  
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42. Click on the I Agree button. The Choose Components screen is displayed. 

 

43. Ensure only the FileZilla Server box is checked. Click on the Next button. The 
Choose Install Location screen is displayed. 

 

44. Install FileZilla Server in the default location. Click on the Next button. The Startup 
Settings screen is displayed. 
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45. Ensure the following startup values 

a. Install as service, started with Windows (default) 

b. Port Number – 14147 

c. Start if user logs on, apply to all users (default) 

d. Both Start Server after setup completes and Start Interface after setup 
completes are selected. 

Click on the Install button. The Installation Complete screen is displayed. 

 

46. After a short time the Close button will become active. Click the Close button and 
the Connect to Server screen is displayed. If the HTML Help Update Program 
window appears, drag it away from the Connect to Server window and continue. 

 

47. Ensure the following startup values 

a. Server Address – 127.0.0.1 

b. Port – 14147 
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c. Always connect to the server is selected. 

Click on the OK button. The FileZilla server screen is displayed. 

 

48. Click on the User Accounts icon at the top of the FileZilla server screen as shown. 
The Users screen is displayed. 

 

49. Click on the Add button at the bottom of the Users box. The Add User Account 
screen is displayed. 

 

50. Type administrator into the top box as shown and click on the OK button. The 
administrator account appears in the Users box.. 
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51. Click on the Add button at the bottom of the Access Rights box. The Browse for 
Folder screen is displayed. 

 

52. Using the tree structure, browse to the following directory: 

C:\Program Files\Infineer\ChipNet3\Card Production\Import 

Click on the OK button. The Users screen is displayed. 

 

53. In the Files box ensure the following values are selected: 

Read, Write, Delete, Append 

In the Directories box ensure the following values are selected: 

Create, Delete, List, + Subdirs 

Click on the OK button. The FileZilla Server screen is displayed. 

 

54. From the Edit menu select the Settings option. The FileZilla Server Options window 
will be displayed: 
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55. From the options on the left pane select Miscellaneous and the Miscellaneous 
options will be displayed in the right pane. Ensure the Start miniminised option is 
selected. Click the OK button. The FileZilla Server window will be displayed: 

 

56. From the File menu select the Quit option. Drag the HTML Help Update Program 
window to the centre of the screen. 

 

57. Click Yes to install the HTML help, or No not to install the HTML help. If Yes is 
selected HTML Help Update Program screen is displayed. 

 

58. Click the OK button. The following MDAC installation screen is displayed in 
Windows 2000. 

 

59. After a short while the following License screen is displayed. 
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60. Ensure I accept all of the…. is selected. Click the Next button. The following 
checking disk space screen is displayed. 

 

61. After a few moments several installing software screens will be displayed until the 
following security edit screen is displayed. 

 

62. After a short pause the Setup is Complete screen is displayed. 
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63. Click on the Close button. The following MDAC 2.8 RTM screen is displayed only 
in Windows XP. 

 

64. Click on the Cancel button. The Installation Complete screen is displayed. 

 

65. Installation of the ChipNet3 files is complete is complete, please click on the Finish 
button. The Restart screen will be displayed. 

 

66. In order to complete the installation the PC must be restarted. Click on the OK 
button. 

 

67. Click on the OK button to restart the PC. 
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10 Installing a card reader 
In order to run ChipNet3, a card reader must be installed. ChipNet3 allows for two card 
reader types, a USB device and a 9 pin RS232 serial device. If the RS232 serial device is 
to be used it is not necessary to install any drivers and you can skip this section of the 
install. To install the USB card reader: 

1. Insert the ChipNet3 Installation CD into the CD drive. 

2. Browse to the CD drive using Microsoft Windows Explorer. 

3. Open the ChipNet3 folder. 

4. Run the file named Setup.exe. The following welcome screen is displayed: 

 

5. Click on the Install button.  The Confirm screen is displayed: 

 

·  Click on Yes button. The install screen is displayed: 

 

·  The blue install bar indicates the progress. Once the files have been loaded the 
Warning screen is displayed. 
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·  Ensure the USB card reader is not connected. Click on the OK button. The 
Information screen is displayed. 

 

·  Connect the USB card reader to the USB port and wait until the Windows Found 
New Hardware Wizard appears. The Connect to Windows update screen will be 
displayed. Ensure No, not at this time is selected and click on the Next button. The 
Welcome to the Found New Hardware Wizard will be displayed. 

 

·  Ensure Install the software automatically  (Recommended) is selected. Click on the 
Next button. The following screen is displayed. 

 

·  After a brief moment the Hardware Installation warning window is displayed. Click 
Continue Anyway button. Once the drivers are installed the following screen is 
displayed. Click the Finish Button. 
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·  Now click on the OK button on the Information window.  

 

·  The Installer Operations Complete screen is displayed. 

 

·  Click on the Finish button. The Installation Complete window will be displayed. 

·  Click the Finish button. The Install window will be displayed. 
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11 Opening ChipNet3 for the first time 
The first time ChipNet3 is launched after the reboot some configuration must be carried 
out in order to open the software and use it.  

1. The following screen will be displayed 

 

2. Type the name of the PC that has the software key attached and click on the OK 
button. 

3. Select the Start menu, then select the Programs menu, then select Infineer, then 
select ChipNet3, then select ChipNet3. The ChipNet3 progress screen is displayed: 

 

Use this screen to view the progress of ChipNet3 as it opens and then the 
Databases tab of the System Setup screen is displayed: 

4. The Terminal Installation Wizard is displayed: 

 

Use this wizard to register details of the PC to add to the system. 

5. Click on the Next button. 

The Terminal Type screen is displayed: 
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Use this screen to enter details about the computer on which you have just 
installed ChipNet3. 

6. Select PC Client Workstation from the Select the Type of Terminal dropdown list. 

7. Enter a description for the computer in the Provide a Description for this 
Terminal field. 

8. Click on the Next button. 

The Terminal Group and Communications Server screen is displayed: 

 

9. Select a group for the computer from the Select a Group for this Terminal 
dropdown list. Click on the Add Group button to add a new group to the system. 

10. Enter a location for the computer in the Enter the Location of the Terminal field. 

11. Click on the Next button. 
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The Register New Terminal Complete screen is displayed: 

 

Use this screen to create the terminal. 

12. Click on the Finish button. 

The Register New Terminal Complete screen is displayed: 

 

13. Click on the Close button. The ChipNet3 taskpad is displayed. 

 

14. Select the Tools menu and then System Configuration. 

15. The Waiting for Card branding screen is displayed. 
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16. Insert a System Set Up Card into the card reader. The System Branded 
information window is displayed. 

 

17. Click on the OK button. The System Configuration screen is displayed. 

 

18. Setup the correct settings for the purses within the tabs for Personal Purse Config 
and Control Purse Config  

19. The following screen is displayed 

 

20. Click on the OK button. 

21. Click on the Close button on the System Configuration window. 
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12 History 

Version Date Comments 

1.0 09/06/03 Document Release 

1.1 13/10/03 Addition of key installation section 

1.2 27/10/03 

Modified card reader installation to reflect new 
method 
Added new screen sequence during component 
install to allow for card reader type 

2.0 16/01/06 New install method 

2.1 10/04/06 Replaced error screen with a warning screen 
Updated requirements specification 

   

   

 

 


